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HIPE Owner's Guide
1. Preface

This document gives you a general overview of HIPE (Herschel Interactive Processing Environment),
the main interface to the Herschel Data Processing (DP) software. HIPE provides a graphical interface
plus command-line access to the data processing capabilities of the Herschel Common Science System
(HCSS).

Read this document if you want to obtain a first understanding of how HIPE looks and its functionality.

Tip

If you are interested in more advanced features, including scripting and batch processing,
please have a look at the Scripting and Data Mining guide.

1.1. When things go wrong
In the unfortunate event of a HIPE crash, or a freeze that forces you to kill the application, please
submit a Helpdesk ticket so that developers can look into the problem.

In some cases, a dump file is created, listing the values of crucial parameters when the crash happened.
Please include it in your ticket, since it will greatly help developers in diagnosing what went wrong.
Here is how to look for the dump file:

• Sometimes HIPE crashes because the underlying Java Virtual Machine has crashed. In this case,
the JVM produces a dump file called hs_err_pid*.log, where * is the process identification
number. This dump file is created in the working directory, that is, the directory HIPE was started
from. If you are not sure, please use the search function of your operating system.

• When you kill HIPE manually, a dump file called hipe_dump_yyyymmdd_hhmmss.txt,
where yyyymmdd_hhmmss is the date and time of creation.

Depending on how you kill HIPE, the dump file may or may not be created. The following table shows
the various cases and the location of the home directory for each supported operating system. Dump
files are created in a .hipe/dumps folder within your home directory.

Table 1. Where and when HIPE creates a dump file

Operating system Dump file created Dump file not created Dump file location

Linux/Unix Ctrl+C or kill kill -9 /home/username

Mac OS Ctrl+C, kill or Force
Quit

kill -9 /Users/username

Windows taskkill or Task

Manager →
Applications

taskkill /f or Task

Manager → Processes

C:\Documents
and Settings
\username
(Windows XP), C:
\Users\username
(Windows Vista)

2. Getting to know HIPE
HIPE (Herschel Interactive Processing Environment) provides an integrated suite of graphical
interfaces that can interact with each other. It allows for interactively choosing your active data in your
session, visualizing that data in various ways and selecting tools that can operate on the data. Both
command-line and GUI interfaces are available. High-level interactions, which can involve GUIs, are
also echoed as commands on the command-line that allow the saving of commands used in a session
and the generation of scripts from these interactions.
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This section provides an overview of the fundamental elements of HIPE.

2.1. The HIPE philosophy
These are the main objectives that guided the development of HIPE:

• An integrated application, giving access to all data processing functionality in a unified graphical
interface.

• A single look-and-feel for window layouts, toolbars, buttons and menus.

• A customizable layout, which allows you to decide which windows are relevant and how these
windows are layed-out on screen.

• User guidance, including command-line echoing of main graphical functionality, allowing you to
learn the scripting language by interacting with the system.

• An extendible application, which can be enriched with new modules that are automatically
integrated.

2.2. Installation and startup of HIPE
Warning

IMPORTANT: before installing HIPE, please make sure that your default file
compression program can unzip FITS files without corrupting them. Otherwise calibration
files shipped with HIPE may be corrupted during installation. For more information see
the Data Analysis Guide: Section 1.3.5.2.

Important

In case of any problems during installation please contact the Herschel Helpdesk via the
Herschel Science Centre website.

HIPE is part of the Herschel Data Processing system. You can download an installer from the Herschel
Science Centre on this page. Installation instructions are provided at the bottom of the page.

If you are an internal user, you can also download the software from these locations:

• More installers on this page.

• Installers for release candidates on this page.

Development builds are available via the Continuous Integration system. These builds are meant only
for Herschel software developers. If you are not a software developer, but you still want to get access
to these developer's builds for any particular reason, please contact our Helpdesk system (details on
this page).

HIPE needs the Java SE Runtime Environment version 6. We recommend to install the latest update
for best performance. To see which Java version is installed on your machine type the following in
a terminal window:

java --version

You can run HIPE on a server or individual workstation under one of these operating systems, either
32-bit or 64-bit:

• Windows XP and Vista.

• Any Linux distribution compliant with the Linux Standard Base version 3.0 or higher. A list of
compliant distributions is available on this page. HIPE may work on non-compliant distributions
too, but this is not guaranteed.

• Mac OS X 10.5 Update 2 or later.

http://herschel.esac.esa.int/HIPE_download.shtml
http://www.rssd.esa.int/SD-general/Projects/Herschel/hscdt/docsDpInstallInfo.shtml
http://www.herschel.be/twiki/bin/view/Hcss/HipeReleaseCandidates
http://herschel.esac.esa.int/esupport
http://www.linuxfoundation.org/en/LSB_Distribution_Status
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The minimum amount of memory needed is two GBytes. Four GBytes are the highly recommended
minimum for data processing; more may be needed in some cases (e.g. large PACS maps).

The maximum amount of memory available to HIPE can be set by choosing the Advanced installation.
To change the available memory afterwards, modify the properties java.vm.memory.min and
java.vm.memory.max in the relevant property file, as shown below:

java.vm.memory.min=64m
java.vm.memory.max=512m

The Advanced installation also allows you to specify the name and location of a Versant database.
Only advanced users and calibration scientists should need to specify a database: if you are unsure
about this option, you probably do not need it.

Recommended browsers to visualize the HIPE Help System are the following:

• Microsoft Internet Explorer 6 or newer.

• Netscape 7 or newer.

• Firefox 1.5 or newer.

• Apple Safari.

Once the software is installed, HIPE can be started by several means. Using Windows, Herschel
software can be started under the Start menu after a standard installation. Alternatively, HIPE can be
started from a command line:

hipe

The installer will tell you where the hipe executable is located.

Note

Under Mac, starting from the command line only works if you installed a developer build
via the Continuous Integration System. If you used the InstallAnywhere installer instead,
you have to start the application via its icon.

When starting HIPE under Windows, you might see two command prompt windows called hipe and
ia_hipe.exe appear alongside the HIPE main window. Both can be safely closed once HIPE has
started.

Upgrading and uninstalling

To uninstall HIPE, either follow the usual uninstallation procedure for your operating system, or
execute the uninstall_hipe command in the uninstall_hipe folder.

It is possible to install different HIPE versions alongside each other. However, the safest way to
upgrade to a new version of HIPE is to uninstall the existing version first.

Important

Most files of a HIPE installation are stored into a .hcss.d folder within your home
folder. This folder is shared among all the HIPE installations on a computer, which means
that the uninstaller will not clean it up to avoid damaging other installations. You can
remove this folder manually after you have removed HIPE completely from your system.
Any HIPE installation left will stop working after removing this folder.

2.3. Obtaining help in HIPE
You can open the HIPE Help System via the Help menu. Help pages will open in a new tab of your
default web browser.

http://herschel.esac.esa.int/hcss/install.php
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Figure 1. Accessing the HIPE Help System.

You can access the following help pages from the Help menu:

• Help Contents: this option will open the main help window. The table of contents on the left
displays the available documentation, with more advanced material appearing towards the bottom
(see Figure 2, still showing the old documentation structure).

• Working in HIPE: this option will open Chapter 1 of the Hipe Owner's Guide, the same you are
reading now.

• Release Notes: this option will open a document with the most recent additions and changes to
the system.

Figure 2. The HIPE Help System home page.

2.3.1. Obtaining help outside HIPE

When you quit HIPE, links in any help pages will not work anymore. Even if you restart HIPE, you
will have to open the Help System again.

To access help outside HIPE you can use the show_help, which resides in the same folder as the hipe
executable. This will bring up the following window:
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Figure 3. The standalone Help System.

Clicking on the Display button will start the HIPE Help System.

For advanced users: accessing the Javadoc

If you are comfortable with Javadoc documentation, you can access it in the HIPE Help System home
page by clicking on HCSS Developer's Reference Manual (API) in the table of contents. To obtain the
traditional frame-based Javadoc layout, click on the FRAMES link on any Javadoc page. To get back
to the HIPE Help System layout you will have to use the Back button of your browser (clicking on the
NO FRAMES link will not work). To have both layouts available, you may want to open the Javadoc
layout in a new tab or window of your browser, by right-clicking on the FRAMES link.

2.4. The HIPE Welcome screen
When you start HIPE you are greeted by a Welcome screen with six icons, which are described in
the next sections. Note that the Updates icon is not yet functional. Placing the mouse over each of the
icons on the screen provides a small description in the status bar at the bottom (see Figure 4).

Figure 4. Information on 'Welcome' screen icons. See bottom strip of the HIPE screen for the explanation
of each icon the mouse is placed over. In this case the Access Data view is stated as being accessible via
the icon the mouse is hovering over.
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You can return to the Welcome screen at any time by selecting Help → Welcome! from the menu bar

or by clicking on the  icon at the top right of the HIPE window.

2.4.1. Icon: Work Bench

Clicking on the  icon takes you to the workbench perspective (for information on perspectives
in HIPE see Section 3.1). The default view of the workbench is shown in Figure 5. This is the main
work area for doing data analysis. Here we can look at data values, plot spectra and images, create
scripts for batch processing and run analysis tools. The contents of the workbench can be updated with
various "Views" available under the Window pull-down menu (see Section 3.1.3 on available Views).

The current default work bench is a somewhat slimmed-down version of the full work bench. Either
perspective on the system can also be be provided via use of the "Window" menu. Selection of the
"Show Perspectives" and either "Full work bench" or "Work bench" provides the two main default
perspectives for when doing work in HIPE.

Figure 5. HIPE default view of the workbench perspective.

2.4.2. Icon: Access Data

The  icon opens up a replacement window in HIPE that provides access to data held in databases
both locally or at a remote site (for example the Herschel Science Archive). It also allows the import
of FITS and ASCII table files into and out of a DP session.

With the access tools you can search and do queries on stored data and its attributes in order to make
it accessible within the processing session.

Four icons appear that allow import/export to databases, direct access to the Herschel Science Archive
or import/export of FITS or ASCII table files (see Figure 6).
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Figure 6. HIPE Data Access initial page.

Clicking on the Herschel Science Archive icon opens the Herschel Archive perspective, while the
Access Data Products icon takes you to the Product Browser perspective (see Section 3.1 for
information on these perspectives).

For FITS and ASCII I/O the other icons produce perspectives that allow for this which are based on
the default Work Bench plus the simple FITS archive tool or ASCII archive tool respectively. These
are discussed more thoroughly in the Data Analysis Guide.

At the bottom of the screen is a large back-arrow button that allows you to return to the original
"Welcome" screen.

2.4.3. Icon: Documentation

Click on the  icon to open HIPE documentation in your default Web browser. For more
information see Section 2.3.

See the Read Me First document for a brief description of all the available manuals.

2.4.4. Icon: Preferences

The  icon allows you to access the Preferences dialogue window shown in the following figure:
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Figure 7. The HIPE preferences window.

You can set preferences in the available categories and revert to the default values at any time. You
can also export/import the values of the preferences to/from an XML file.

2.4.5. Icon: Updates

The icon  functionality is not implemented yet. Clicking on this item will allow you to search
for software updates available from the Herschel Science Centre.

At the bottom of the screen is a large back-arrow button that allows you to return to the original
"Welcome" screen.

2.4.6. Icon: External Tools

The icon  takes you to a set of icons linking to Virtual Observatory tools, including VOSpec,
VOPlot and Aladin. Included in this listing is the Herschel Science Archive (HSA) browser, as
Herschel components are VO-compliant. The HSA also uses a VO-like interface with HIPE. Clicking
on any of the icons launches the external VO tool. Help and assistance with these tools are provided
separately from within the tools or associated websites, except for the HSA browser interface which
is described in this manual.

When you click on the icon of an external application, it will be automatically downloaded and
launched. After the download you may see a security dialogue window telling you that the application's
digital signature is missing or has an error. For the applications shown in this window you can safely
click on the Run button. You can check the Always trust content from this publisher checkbox to avoid
being prompted again.

Note

An external application is downloaded the first time you click on its icon, and whenever a
new version becomes available. Note that the application will be downloaded even if you
have a version already installed on your hard disk.
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At the bottom of the screen is a large back-arrow button that allows you to return to the original
"Welcome" screen.

3. Views and perspectives

3.1. HIPE Perspectives

When going to the workbench or using the welcome icon link to the data access capabilities of HIPE,
you are presented with a perspective. A "perspective" is a presentation of the system that is made
available to you through a set of "views" (basically separate windows within the environment that
provide particular capabilities). The following section discusses the available views, but in this section
we describe perspectives and in particular the default workbench perspective. We also discuss how
you can control a perspective to make it as simple or as complex as wished.

HIPE is built-up from several graphical elements, of which the fundamental ones are shown in Figure 8,
which provides the full work bench. A perspective may consists of one or more related views and,
optionally, the editor area; these windows are then organized in tabbed panes and split panes. Many
of the views also contain their own toolbars. These toolbars are in addition to the toolbars for HIPE
displayed at the top left (editor capabilities for editor window view) and right of the HIPE screen
(icons providing access to full set of defaults perspectives -- hover mouse over icon to view perspective
name).

Figure 8. A single element (view) for a HIPE perspective.

3.1.1. Available Default Perspectives

There are five perspectives that come pre-packaged in the system. These can always be obtained
by using the toolbar at the top of the HIPE window. Click on "Window" and pull down to "Show
Perspectives", which provides the list.

Product Browser Perspective

The Product Browser perspective provides a convenient means of getting and briefly viewing data
from databases and data stores, both locally and remotely stored. This is illustrated in Figure 9. There
are four main windows (views) including an editor where scripts can be created.

For more information see the Data Analysis Guide: Section 1.2.5.2.
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Figure 9. Product Browser perspective. This provides access to data stores both on-line and on your
computer.

Classic(JIDE) Perspective

The Classic JIDE perspective provides a scripting environment with 3 windows that provide an editor/
debugger window, a console window and a log window. This is the basic view of the system used
during earlier development of the DP system (see Figure 10). A new Jython (DP) script window can

be added by clicking on the  icon at top left of the Editor window.

The same perspective can be obtained by clicking the  icon to the top right of the HIPE window.
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Figure 10. HIPE's 'classic' JIDE perspective.

The Full Work Bench Perspective

The Full Work Bench perspective provides a general environment with multiple windows, five
of which are prominent (editor, console, variable list, outline, run tools). Other windows/views are
available by clicking on the tabs, e.g., Navigator, Classes (see Figure 11).

Figure 11. HIPE view of the full work bench perspective.
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The Work Bench Perspective

The Work Bench perspective provides a slimmed-down general environment similar to the work
bench but with only with four windows (views). The editor, console, variable list, outline, tasks views
are available (see Figure 12).

Figure 12. HIPE default view of the work bench perspective.

Archive Browser

The Archive Browser perspective provides a convenient means of querying and obtaining data from
the Herschel Science Archive (HSA). There are three views related to providing log-in information
for the HSA, the connection to the HSA (via plastic VO protocol) and the loading of selected data
from the archive (see Figure 13).

Queried data appear under a single, selectable variable in the DP session (under Variables view) and
a click on the variable allows its outline to be provided in the Outlines view. These two views are
described in more detail later in this chapter.
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Figure 13. HIPE Archive Browser perspective. This provides access to the Herschel Science Archive (HSA).

3.1.2. Changing HIPE Perspectives

You can modify a perspective in various ways. Each window can be resized or dragged to different
areas of the workspace. Also, new views can be added to a perspective.

Adjusting individual views

Each individual window can be adjusted in the following ways:

• Window resizing. These can be adjusted in a standard way. To the top of each window, the cross
( X )on the tab being clicked removes the window/view. The underscore line minimizes a window
( _ ) while the window can be maximized or returned to its original size by clicking of the box figure
in the tab at top right. Minimized windows appear to bottom left of the workspace (see Figure 14).
Holding the right mouse button down while on the window tab also provides a menu which includes
the same options.

Clicking and dragging borders of each of the windows allows for expansion in any direction of any
of the views.

• Window Tab Placement. A right click on the view tab provides a pull-down menu that allows
some default window resizing and also tab placement and direction of written label (see Figure 15).

• Moving Views. Windows can be moved inside the HIPE workspace by clicking on the window
itself and dragging to another part of the worksurface. Outline black boxes appear on the screen
indicating where the window would be if the mouse button was released at that point.

It is also possible to completely Undock a window view by holding the right mouse button down
while on the window tab. Pulling down on the menu to "Undock" allows the view to become a
separate window that can be moved completely off of the HIPE surface (see Figure 16 for an
example). To move this undocked window, click on the title bar and drag it.
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• Moving Between Windows in a View. Windows can be moved inside a view using the arrow
buttons to the top right of the view. The left and right arrows toggle through the windows available
in a view, while the down arrow allows window selection from a list (see Figure 17).

Figure 14. Minimized window appearance at the bottom of the HIPE window.

Figure 15. Changing tab positions in a HIPE view.
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Figure 16. Example of undocking a view using HIPE. In this case the Editor view has been undocked and
now sits "over" the HIPE worksurface and can be dragged elsewhere.

Figure 17. Selecting windows within a view. The down arrow shows the list of windows available in the
Editor view.

Adding New Views to the Perspective

Several additional views can be added to a perspective. The complete list is obtained from the Windows
menu on the toolbar at the top of HIPE. Pulldown to "Show Views" to show the available views in the
system. Click on one to add that view to the current worksurface (see Figure 18).
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Figure 18. The 'Show Views' selection from the Windows pulldown menu lists the views that can be added
(note: if the view already exists then a new one is not added).

3.1.3. Available Views And What They Allow You To Do

Each view has particular capabilities that can be combined to provide a powerful interactive
environment. However, the environment can be simplified to a few windows to make a perspective,

as noted above. The views available under the Window → Show View menu can be added to any
perspective.

Classes

This view lists all the classes (routines) currently available in the session. These can include scripts
you loaded into the system. Help information for any of the classes can be obtained by use of a right
mouse button click. This brings up a small menu which provides access to Help.

Help information on a class appears in the "Topic Help" view.

Both these views are available as default "Workbench" perspectives (see Section 3.1.1).

Console

The Console view is also available in the default workbench window. It provides a command-line
interface to all HIPE commands and functions.

Re-running commands. It is possible to cut and paste command lines into the window. It is also possible
to rerun commands by clicking on the window then hitting the up arrow key until the command that
requires repeating is reached. Editing of the command line can then be done before hitting return again
to rerun the (edited) command.

Note that the console inputs are the same as for the classic JIDE case and its full use is described in
the Advanced User's Manual. Outputs such as plots or images will appear as separate tabbed windows
within the editor view (see below for more information on the Editor view).

The console window is also where printed output from routines appears. So a routine that involves a
print output will provide that printed output to the Console view (see Figure 19).
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Figure 19. The Console view is where command-line input can be made and where feedback command-
lines appear following the use of a GUI.

Data Access

This view brings up the interface for downloading data into a session (see Figure 20). This provides a
mechanism for interacting with a set of data on your machine, or data contained in remote databases,
including the Herschel Science Archive (HSA). The data can be accessed by several means;

Figure 20. Outline of a variable in the DP session is shown in the Outline view.

• Observation: which allows querying for observations by target, proposal information, instrument
or observation id/day of observation.

• Attributes: which allows data selection via attributes in the data products such as creation date and
instrument model.

• Meta Data: which allows selection based on metadata associated with the products in the database
(TBD).

• Data Mining: which allows selection based on information contained within the science data
themselves (TBD).
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Editor

The Editor view is where scripts are displayed and can be edited (see Navigator view information).
When you open a Jython script, a set of editing commands becomes available under the Edit menu
(see Figure 21) and as icons in the toolbar below. Hover your mouse over each icon to obtain a tooltip.
The run icon will run the highlighted lines in the edit window. If no lines are highlighted then the line
with an arrow in left-hand side grey region will be executed (see Figure 22).

You can customise the Editor window for Jython scripts and other text files by choosing Edit →
Preferences. This opens the main HIPE Preferences window. Set the options under Editors & Viewers

→ Jython Editor and Editors & Viewers → Text Editor to change how the editor behaves.

Figure 21. The Edit menu.

Figure 22. The Edit arrow is placed next to the line to be executed next. In this case, the Display task would
be called once the Run button was clicked.
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Once a script is initiated, it can be halted by clicking the red highlighted square (Stop) icon. NOTE:
the current line of the script will be completed before the script stops running. This can lead to a delay
before coming to a halt.

The Editor view is also where informational overview or the contents of a DP file type are displayed
-- when requested. It is also the area where plots -- which are in themselves editable, e.g. zoom, pan,
change of labeling, task dialogs etc. -- are placed. Examples are shown in Figure 23 and Figure 24.

Figure 23. A window shows metadata associated with an image within the Editor view.

Figure 24. Window showing a task dialog associated with an image rotation within the Editor view.

The area can hold several (tabbed) windows so multiple plots/scripts/file contents can be open at one
time.
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Export Herschel Data from HIPE

This view allows Herschel data to be exported from the session into a directory structure which is
identical to the one found in the tar file of observations that are received fromt he Herschel Science
Archive following a request for data.

Herschel Login

In this view you can login to the Herschel Science Archive (HSA). It is also available as part of the
Access Data perspective noted previously. See Figure 25.

Figure 25. The Herschel Science Archive login screen provided by the Herschel Login view.

Herschel Science Archive

In this view you can access the Herschel Science Archive (HSA). It is also available as part of the
Access Data perspective noted previously. See Figure 25. You can get the HSA interface by clicking
the "Open HSA User Interface" button. Once selection is done then the "Load Selected Products"
button will bring selection into the HIPE session.

Figure 26. The Herschel Science Archive interface view.
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HIFI pipeline

This has not been fully implemented yet, but will be a specific view from within which it will be
possible to run HIFI pipelines (in part or full).

History

The History view provides a listing of the commands executed at the console or lines executed from
the Jython script window of the Editor. This also shows whether the command was successful or not.

A tick ( ) indicates the command supplied was successfully executed. A white cross in a red

circle ( ) indicates that there was a problem when performing the command. A click on the small

plus sign in a circle ( ) next to this will expand out the error information including a complete
traceback (see Figure 27).

Figure 27. A traceback of errors is available from the History window.

History can be saved and used for later batch processing. A right click on the History window allows
the commands listed to be either copied or saved to hard disk, enabling the contents to be used within
scripts edited in the Editor window or storage of the command listing. Later sessions can then easily
import the saved history into the Editor view for re-execution.

Import Herschel Data into HIPE

This view allows Herschel data to be imported from the tar file of observations that are received fromt
he Herschel Science Archive following a request for data. This creates a context for the observation
in HIPE that is easily navigable.

Log

The log screen provides a logging of the commands that have been executed from the command-line
or the equivalent from dialog interactions in HIPE. It also indicates warnings generated in the system.
The warning system level can be adjusted by the pulldown menu available at the arrow to top right of
the window, from FINE to SEVERE warning levels (see Figure 28).



HIPE Owner's Guide

22

Figure 28. The Log screen with pull-down menu showing warning levels that are to be filtered and displayed
in the Log view.

Navigator

The Navigator view provides access to the files and directories on your disk. By default it provides
a listing of your home directory. Certain types of stored information can be brought into the session
and displayed. A right click on an item in the Navigator list provides items indicating what may be
done with the particular file (see Figure 29).

A prime example of using the Navigator tool is in loading a Jython script (file ending with .py). A right
click and pull down to "Open With..." then "Jython Script Editor", will open the script up in an Editor
view window (the Editor view can hold several, tabbed, windows). Scripts can also be run directly
from the same menu, with the "Run Script" item appearing on the menu. Although the scripts need to
be self-contained requiring no parameter inputs.

Figure 29. The Navigator view for HIPE showing the options available for the selected item on the system.
Double-clicking on a ".py" script will open the script in a new Editor view window.

Outline

The outline information on a given variable is placed in this uneditable view. Clicking on the variable in
the "Variables" view (see Section )provides an output of its name, variable type (class) and the herschel
package in which this variable type is defined. In Figure 30, the DP session variable myImage2 is
shown to be an image dataset which could be viewed using the available DP Display task (for example).
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Figure 30. Outline of a variable in the DP session is shown in the Outline view.

NOTE: This window provides information only, and its contents cannot be manipulated.

Packages

This view brings up a panel that provides access to the packages that are currently available to the
session (see Figure 31. To get further information on what is available in a given package, double-
click on one of the folders displayed. Package documentation associated with the available commands

( ) can be obtained by clicking on the command or right click on the item in the Package view and
pulldown to "Help". Documentation appears in the "Topic Help" view. Note that the documentation
provided at this level is not for the general user but more for those wishing to use to use package
elements to develop scripts etc. within the HCSS.
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Figure 31. The Package view which is one of the tabbed views to the top left of the default Workbench
perspective. Information on a package item is shown in the Outline view.

Information on the package item is provided in the Outline view when the item is highlighted.

PAL Storage Manager

In this view you can setup storage areas (mini databases) storing data in the structures used to store
Herschel observations. These areas can then be queried and read from and data can be stored in them.

Save Products to Storage

In this view you can save data (Herschel data products) from your session into a store. See the Data
Analysis Guide for examples: Section 1.2.7.

Tasks

This provides a list of tasks and tools available in HIPE. These can be applied to variables of the
appropriate type in a session. A right click on the available task allows a menu with a pulldown that
includes "Open With...". This allows a Task dialog where the task can be applied to a given set of
data. Some example workflows are given below.
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When a variable (see Variable view, below) is highlighted, available tasks appear as available in the
"Tasks" listing. The Tasks are available in three folders; All, Applicable, and By Category. The "All"
folder shows all available tasks in the system, while "Applicable" tasks are those that are designed and
registered to run with data of the type associated with the highlighted variable in the Variables view.
The folders can be opened or closed with a double-click. To start a task working on the data variable
highlighted, simply double click on the task shown in the list (see Figure 32).

Figure 32. Tasks available for a given DP session variable are automatically made available in the "Tasks"
view. Applicable tasks are shown in the Applicable Tasks folder.

Most of the tasks needed for basic data analysis can be accessed in this fashion. More information
on how to use tasks for general data analysis is provided in the set of HowTos that are available in
the main Help window (e.g., go to "Help" in the main toolbar at top left of HIPE, which opens up a
window with access to the full user documentation).

Double-clicking any task in the Tasks view brings up a GUI dialog in the Editor view. This can be
used to run the task in the appropriate way. In all cases an "Accept" button, to bottom right of the
dialog, under the progress bar, should be clicked to run the task with the given inputs (see example
task dialog at Figure 24).

Variables

This view shows the variables established in your session that you can use. You can always see what
they are in two ways.

• Click on the variable in the Variables view. It's description and outline are shown in the Outline
view (see Section ).

• You can print the contents to the screen in the Console view (see Section ) by the command

print <variable name>

Clicking on a variable in the Variables view enable you to see what type of variable it is (this appears
in Outline view, Section ). In this way it is possible to look at the structure of a complex item in your
session containing multiple groups of spectra or images.
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A right mouse click on a variable allows a short menu to appear which provides the possibility to do
the following:

• Get help information on the variable type. The help information appears in a new browser window
tab, and is the User Reference Manual information for the given variable type(see Section 2.3).

• Delete the variable from the session. Note that the equivalent command-line will appear in the
Console view (see Section ).

• "Open with" allows a list of ways to view the variable other than in outline (e.g., if it is a table you
can use a Dataset Viewer, see Figure 33 or Spectrum Viewer for spectra). These viewers currently
provide output in the Editor view (see Section ).

Figure 33. Tools available for a given DP session variable are automatically made available in the "Tasks"
window.

Welcome

Opens up the initial startup window.

3.1.4. Viewers in HIPE

A convenient feature of HIPE is that recognizes the type of variables held in a session (is it a dataset,
a spectrum, an image, a scalar constant etc). Items appearing in the "Variables" or "Outline" views,
with a green dot beside to their left, can potentially be opened. A right mouse click on any of these
variables appearing in a DP session will provide a small menu of options to "Open" the variable or
"Open With..." or "Delete" or get help on ("Help Selection") the variable chosen. As previously noted
in the "Variables" section.
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Choosing "Open" allows opening with the first item in a list of available viewers for the selection.
But there can be more than one viewer. These are shown under "Open With...". One of the viewers is
chosen as the default for a double-click on the variable -- and this is shown with a dot beside it.

An example is shown for SimpleImage. A right-click on a variable of this type in the "Variables"
window shows there are two viewers (see Figure 34). The Product viewer will show associated
metadata and array values while the second viewer displays the image (more is provided in the HowTo
on Display and Manipulation of Images).

As examples, viewers are available to show information on headers (metadata), and datasets
(numerical arrays), enable table plotting and exploration, show images and/or spectra.

Figure 34. Available viewers are shown with a right-click.

4. Saving/playing back scripts in HIPE
HIPE keeps a running record of all items typed or actions taken using the graphical interface (Mouse
points and clicks). The purpose of this article is to identify the steps you can take to save this
information. The goal is to be able to keep a record of all actions and create a Jython script which
can be resused or slightly modified.

These are the steps to follow using to save all the commands which were given to HIPE during your
session. In the tab bar with the Console view there is a tab called history. You can also bring this
History view up from the Window--Show view pull down menu.

1. In the History view. Mouse left mouse click on the column called "Command". The entire column
should be now selected.

2. From the "File" button at the top left of the HIPE window, create a new (blank) Jython script.

3. Then right-mouse click on the selection and Choose copy.

4. Move the cursor to the blank Jython script page and either select the "Paste" command in the Edit
pull down menu or type Ctrl-V. The script will appear in the Editor window.

5. Your new Jython script can be saved for later importing (via the Navigator view).

The following screen shots show what is described above.
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And...

To save the script to file (default extension .py), click on the Editor view tab that contains the script
-- which brings the script to the foreground -- then press CTRL-S. The file will be saved. If you have
not already provided a directory and name for the script then you are prompted for one, otherwise the
previous version is overwritten at the same place in your directory structure.

Alternatively -- click on the appropriate Editor tab (as above) and then go to the "File" pull-down
menu at top left of HIPE. Go to "Save" or "Save As...".

You can also play back a saved script that is on the disk using the execfile command. Enter
something similar to the following on the command-line of the Console view (do not forget the
quotation marks).
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execfile("<full path name><file name>")

5. IDL to HIPE/Jython command mapping
The following tables contain the HIPE/Jython equivalents of the most common IDL commands and
functions.

Table 2. Basic commands

Command IDL HIPE/Jython equivalent

Create a variable a = 5 a = 5

Get info on a variable type help,a    print a.__class__

Print value of variable print, a print a

Create an array a = [2., 3.] a = Float1d([2., 3.])

Create a list - a = [2., 3.]

Create an automatic array a=findgen(10) a=Float1d.range(10)

Get info on array variable print, a print a

Get one element of array print,a(1) print a[1]

Define new 1D array of 10
elements

a = fltarr(10) a = Float1d(10)

Assign value inside an array a(4)=219 a[4] = 219

Define new 2D array of 10,5
elements

a = fltarr(10,5) a = Float2d(10, 5)

First element index number 0 0

Table 3. Plotting

Command IDL HIPE/Jython equivalent

Open a plotting window window,retain=2 p=PlotXY()

Plot two numeric arrays a & b plot,a,b p=PlotXY(a,b)

Define axis ranges and styles plot,a,b,[xy]range=[0.,10.],
[xy]title=

PlotXY(a,b,[xy]range=[0.,10.],
[xy]title="$\lambda$)

Define linestyle plot,a,b,linestyle=1 p.style.line=2 (later)

Define plotting symbol plot,a,b,psym=2 p.style.symbol=5 (later)

Define plot title plot,a,b,title='title' PlotXY(a,b,title='title')

Overplot oplot,a,c p[1]=LayerXY(a,c)

Make Annotations xyouts,0.2,0.7,Label' d.addAnnotation("Label", 0.2,
0.7)

Make postscript hardcopy set_plot,'ps'

device,filename="file.ps"

device,/close

set_plot,'X'

p.saveAsEPS("file.ps")

Make a JPG hardcopy - p.saveAsJPG("file.jpg")

Make a PNG hardcopy - p.saveAsPNG("file.png")
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Command IDL HIPE/Jython equivalent

Make a PDF hardcopy - p.saveAsPDF("file.pdf")

Further customizations - (right-click on plot and select
Properties)

Table 4. Importing/exporting data

Command IDL HIPE/Jython equivalent

Reading an ascii table readcol,'file.dat',a,b,c t = simpleAsciiTableReader(file
= "file.dat")

Plot read data plot,a,b p=PlotXY(t["c0"].getData(),
t["c1"].getData())

right-click on "t" and Open with
"TablePlotter"

Read a Comma Separated Table
(.csv) ascii table

readcol,'file.csv',

DELIMITER=','

t = asciiTableReader(file =
"file.csv")

Read a image FITS file im=mrdfits("image.fits") im = fitsReader(file =
"image.fits")

Display image tvcsl,im right-click on "im" and Open
with "ImageViewer"

Read a cube FITS file cube=mrdfits("cube.fits") im = fitsReader(file =
"cube.fits")

Display cube - right-click on "cube" and Open
with "CubeAnalysisToolbox"

Read a spectrum FITS file sp=mrdfits("spec.fits") sp = fitsReader(file = "spec.fits")

Display spectrum plot,wave,flux right-click on "sp" and Open
with "SpectrumExplorer"

Writing to FITS mwrfits,image,'image.fits' simpleFitsWriter(product =
image, file = "image.fits")

Writing an ascii table (csv by
default)

get_lun,u

openw,u,'file.csv'

printf,u,a,b

close,u

free_lun,u

asciiTableWriter(table = t, file =
"file.csv")

Table 5. Arithmetic

Command IDL HIPE/Jython equivalent

Adding 3+4 3+4

Multiply 3. * 4. 3. * 4.

Powers 3^4 3**4

Absolute abs() absolute(), fabs()

Arc cosine acos() arccos()

Natural logarithm alog() log()

10th base logarithm alog10() log10()
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Command IDL HIPE/Jython equivalent

Arc sine asin() arcsin()

Arc tangent atan() arctan()

Ceil ceil() ceil()

Conjugate conj() conjutage()

Cosine cos() cos()

Hyperbolic cosine cosh() cosh()

Exponential exp() exp()

Floor floor() floor()

Invert (matrix) invert() Matrix (module)

Bit shift operations ishft() right_shift(),left_shift()

Sine sin() sin()

Hyperbolic sine sinh() sinh()

Square root sqrt() sqrt()

Tangent tan() tan()

Hyperbolic tangent tanh() tanh()

Random 0-1 generator randomu() random()

Reverse array 'a' reverse(a) a[::-1]

Collapse of array total(a) sum(a)

Number of elements n_elements() len(), size()

Number of parameters n_params() len(*args)

Extra parameters _extra **kwargs

Size size() shape(),arrayvar.type()

Pause time wait time.sleep()

Execute  script execute() exec()

Thse are external resources that you may find useful:

• IDL to Python

• Jython homepage

• Python for astronomers

Note that HIPE does not include the latest Jython version, so examples from these external sites might
not always work.

http://www.johnny-lin.com/cdat_tips/tips_array/idl2num.html
http://www.jython.org
http://www.cfa.harvard.edu/~ebresser/python
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